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1 ABOUT THIS MANUAL

The User's Manual is planned to assist the user in (i) understanding the ANEMI model structure; and (ii)
learning how to use the model for policy simulation. ANEMI model is a research product and is not
developed as a commercial software. This manual contains a brief description of the main features of
the Vensim system dynamics simulation software (Ventana, 2010), as well as integrated simulation-
optimization procedure developed by incorporating MATLAB (MathWorks, 2007) functionalities with
Vensim system dynamics simulation. With the help of Vensim and MATLAB software packages, the user
can use, modify and/or run the ANEMI models provided with the manual. The step-by-step instructions
are provided for using ANEMI model for policy simulation. Advanced features of the ANEMI model, such
as subscripting (arrays), linking external functionality to implement optimization within simulation, are
presented using ANEMI simulation models as an example to accelerate the learning process. This
manual also contains a detailed description of DLL (Dynamic-Link Library) file generation procedure by
Visual Studio software package (Microsoft, 2008). The full description of the ANEMI model is provided in
Akhtar et al (2011) available on the CD-ROM.

1.1 INTRODUCTION

An integrated system dynamics model is developed to assess the impacts of climate change on society-
biosphere-climate-economy-energy system (Akhtar et al, 2011). This manual is prepared for ANEMI
model users. The ANEMI system dynamics model consists of nine sectors/components:
» Carbon;
Climate;
Land-Use;
Food Production;
Population;
Energy-Economy;
Hydrologic Cycle;

Water Demand; and

V V V V V V V VY

Water Quality.



The conceptual links between these nine sectors are shown in Figure 1.1. The carbon sector computes
the atmospheric carbon dioxide concentration by considering the carbon exchange among ocean, air,
vegetation, humus and industrial emissions. The atmospheric temperature is produced by climate sector
taking into consideration the radiative forcing from different sources. The land-use sector deals with the
change of land-use by converting forest area to agricultural land and agricultural land to urban land to
meet the needs of growing population. Food production is driven by the availability of agricultural land,
allocated capital, water availability and land fertility. The requirements for the increase in food
production are driven by the population growth and per capita food demand. The population sector
computes the total population in each year for four different age groups (0 -14, 15-44, 45-65, 65 and
above) based on the desired number of children per family, birth control effectiveness, availability of
resources, and other factors. The energy-economy sector is formulated on the basis of market clearance
optimization. The energy-economy sector produces GDP, energy production and fossil fuel based
emissions. Hydrologic cycle is represented as surface water sector in the ANEMI model, which computes
precipitation, runoff, groundwater flow and other components of the hydrologic cycle. Water demand
sector calculates the demand for agricultural, domestic and industrial water uses. Water quality sector
deals with the physical and chemical characteristics of water based on the use and average pollution

load that is coming from each type of water use (domestic, industry, and agriculture).

Land Use
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Arable Land_+ ﬂssmn
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Figure 1.1: Major intersectoral links of ANEMI model



A detailed description of the inter-sectoral as well as intra-sectoral feedback relationships is available in
the main report (Akhtar et al, 2011). The ANEMI model is calibrated and verified against available
observations from 1980 to 2008 and information available in published literature. The model
performance is presented in the report to demonstrate the robustness of the ANEMI model as a climate
change policy analysis tool. The intension of this modeling effort is not the prediction of the future
system behaviour, but increased understanding of the complex interactions of society-biosphere-
climate-economy-energy system and response of different system sectors to various climate change

mitigation and adaptation policy options.

This manual should guide the users in operation of this system dynamics model for a range of land-use
conditions, water use policies, carbon tax implementation options and other policy alternatives. Two
versions of the ANEMI model are available: global and regional. The instructions in the manual apply to
both of them. The manual should help the users get familiar with:

e Vensim;

e MATLAB;

e VisualStudio; and

e Microsoft-Excel.

1.2 Organization of the Manual

This Manual is broadly divided in three parts. The first two chapters (Chapter 1 and Chapter 2) provide
basic information on the use of Vensim software (Ventana, 2010). Chapters 3 and 4 cover the mechanics
of building ANEMI model by integrating Vensim with other supporting software, and Chapter 5

demonstrates some advanced features of ANEMI model for policy implementation and analysis.

Chapter 1 provides an overview of this Manual. Chapter 2 introduces the user to the Vensim User
Interface and provides instructions for the installation of Vensim software. This chapter provides an
overview of Vensim’s functionalities, along with information on the Sketch tools, Analysis tools, and

Control windows. Chapter 3 provides a brief description of the ANEMI model, model experimentation



and policy description. Chapter 4 introduces other software packages required for the ANEMI model
simulation and their installation procedures. A detailed description of the integration procedure of
MATLAB and Vensim modeling tools through Visual Studio are also presented. Chapter 5 describes three
simulations which are related to different policy scenarios presented in the main report (Akhtar et al,
2011). This chapter also contains step-by-step procedure for the implementation of three policy
scenarios in both, global and regional versions of the ANEMI model. Appendix A contains the MATLAB
optimization code MATLAB for the energy-economy sector. This appendix contains programming code
for both, global and regional model, where ‘fsolve’ functionality is used to find a root (zero) of a system
of nonlinear equations. Appendix B includes all the necessary programming code in Visual Studio to
generate a Dynamic Link Library (*.DLL) files, which are utilized by Vensim; and Appendix D presents the

parameter estimation codes (in R programming language) developed for the disaggregation model.



2 VENSIM

Vensim (Ventana, 2010) is a visual system dynamics simulation modeling tool, which allows user to
conceptualize, document, simulate, analyze, and optimize models of dynamic systems. Vensim provides
a simple and flexible environment for building simulation model from the causal loop diagram, as well as
presenting it using stock and flow diagram. By connecting words with arrows, relationships among
system variables are entered and recorded as causal connections. The model can be analyzed
throughout the building process, looking at the causes and uses of a variable, and also looking at the
loops involving a variable. After completion of the model development, the model can be simulated and

user can thoroughly explore the behaviour of the model.

2.1 Vensim Basic Information

2.1.1 Directories

The typical installation path for Vensim is C:\Program Files\Vensim\models. However, the user can
install Vensim software at any location. When working with the model, it is strongly recommended that

the Vensim subdirectory be avoided (in this case C:\Program Files\Vensim).

2.1.2 Screen Shots

There is difference in the appearance of Vensim PLE, PLE Plus, Standard, Professional and DSS software
versions. All the pictures/screen views in this manual are extracted from the Vensim DSS and default

Toolsets (Ventana Systems, 2010).

2.1.3 Tab Dialog Boxes

Tab Dialogs are special dialog boxes common for Windows 95 and later versions of Windows. These
dialog boxes simplify controls by separating information into different "folders" with tabs. The user can

switch between folders by clicking on the appropriate tab.



2.1.4 Vensim Installation

To install Vensim, user needs to get the software, either from the CD or as a download from the

VENTANA Systems, Inc. website (http://www.vensim.com, last accessed, August 2011).

The Vensim CD
The Vensim CD contains the installation programs for all Vensim configurations. The label of the CD will
show the version number. Though installers for all configurations are included, the user will only be able

to install the specific configuration, as per the license agreement.

Downloading Vensim
The user is allowed to download Vensim from the website of VENTANA Systems inc. after the purchase
of Vensim license that includes one year of free electronic updates. The direct link for downloading

Vensim is http://www.vensim.com/cgibin/download.exe (last accessed, August 2011). This link is

available only with the valid registration code. The registration code identifies the productTo download
Vensim PLE (free version of software) for educational purpose, user needs to visit

http://www.vensim.com/freedownload.html (last accessed, August 2011).
The Windows installer is broken into a number of relatively small files. The first of these files has a name
that depends on the product (for example, vendss32.exe for Vensim DSS). The remaining files are

labelled disk2.vip, disk3.vip and so on. When downloading, users must save all the files in the same

directory and it is very important that user should not change the name of any file.

2.1.5 Vensim Installation

Installation of the software can be done from the provided CD or downloaded files.


http://www.vensim.com/
http://www.vensim.com/cgibin/download.exe

From CD
Insert the CD into the computer and follow the installation dialog. If there is any other previous version
of Vensim installed then the user may see the screen as shown in Figure 2.1. If this dialog does not open,

user needs to double click on the program file (setup.exe) on the installation CD.

Vensim® DSS DblPrec Version 5.1b Installation ﬁ
‘Welcome toVensim® 0SS DblPrec Setup. This program will install
Wensim® DSS DblPrec onyour cormputer along with supporting files

&

The installation of Vensim® DSS DhiPrec will not make any changes to
existing programs. To uninstall Yensim® DSS DhiPrec run uninstall from
the control panel

Installation and use ofthe Vensim® DSS DblPrec Software is subject to the terms of a license agreement
which will appear after you click on Next>

Copyright® 1986-2002 Yentana Systems, Inc. Wensim is covered by U3 Patents 5,426,740 and
5446652, Vensim and WVentana are registered frademarks of Ventana Systems. Inc,

Mext> Cancel

Figure 2.1: Initial Vensim installation screen

From the Installation Choices dialog, select the program that needs to be installed (Figure 2.2). The
installation starts by clicking on Install a Registered Vensim Application and entering the registration

code.

»] Yensim@® 5 Installation Choices x|

| Install a Registered Vensim Application i

Redgistered applications include PLE, PLE Plus, Standard, Professional,
DSS. Runtime, and Application Runtime. Y'ou will need ta supply a
registration code.

Install the Yensim Model Reader

Install the Yensim Demonstration Program

Install Vensim PLE for Academic or Evaluation Use I

Open the Yensim Documentation fram the CD
The User's Guide is available as an adobe Open the User's Guide in Acrobat I
acrobat file. |f you do not have Acrobat
Reader installed you can install it from here. Install &xdobe Acrobat Reader |
Cloze thiz dialog I

Figure 2.2: Installation choice dialog box



From Downloaded Files
Double click on the first file (for example, vendss32.exe for Vensim DSS). This will be in the directory

selected by the user during the download procedure.

2.1.6 Registration Code

Vensim DSS, Professional, Standard, PLE Plus and PLE for commercial use require a registration code.
Vensim PLE for educational or evaluation use do not require a registration code. Use of the ANEMI
model requires a licensed version of Vensim software, which allows work with the external

functionalities.

2.2 Main Features of Vensim Software

Vensim uses an interface workbench and a set of tools. The main Vensim window is the workbench,
which always includes the Title Bar, the Menu, the Toolbar, and the Analysis tools. When Vensim model

is open (Figure 2.3), the Sketch Tools and the Status Bar also appear.
Title Bar Menu  Main Toolbar Sketch Tools

+] ¥ensim:pop.mdl ¥ar:Popi ' ation = Ell_l
File Edit VYiew Layout Model Tools Windgfws Help - J

2@ |8 soe DX [sEif 0d 8206

be[EM Rk R PRGN NKE | w g
o
@
Doc ) =————p=| Population = -
births deaths

Analysis Tools Status Bar  Sketch Drawing Area

Figure 2.3: View of the workbench window

The workbench variable is any variable in the model selected by the user. The workbench variable is

selected by clicking on a variable or by using the variable selection control in the control panel.



2.2.1

Vensim Menu

Many operations in Vensim can be performed from the menu.

File Edit “iew Layout Model Tools Windows Help

>
>

The File menu contains common functions such as Open, Save, Print, etc.

The Edit menu allows the user to copy and paste selected portions of the model.

The View menu has options for manipulating the sketch of the model and for viewing a model
as text-only (available only in Vensim Professional and DSS).

The Layout menu allows user to manipulate the position and size of elements in the sketch.

The Model menu provides access to the simulation control and the time bounds dialogs, the
model checking features, and importing and exporting datasets.

The Tools menu sets Vensim's global options and allows the user to manipulate analysis tools
and sketch tools as well as to set global options.

The Windows menu enables the user to switch among different open windows.

The Help menu provides access to the on-line help system.

Menus are context sensitive and the commands apply to whichever window currently is active. The

most commonly used menu commands also have shortcut keys and can be performed from the toolbar

described below.

2.2.2

Toolbar

The toolbar provides buttons for some of the most commonly used menu items and simulation features.

The first set of buttons access ‘File’ and ‘Edit’ menu items.

EH |8 sm@
7

New Model OpenModel Save Print Cut Copy Paste

The next several buttons and the Runname editing box are used for model simulation.



Edl &% |Currgnt #% kWO

Control Runname Simulate | Game | Optimize
Setup a Choose SyntheSim Sensitivity Reality
Simulation Runname Check

The last few buttons access the window classes. User may need to click on a button to bring forward

that type of window or circulate through windows of that type.

& B Gud
Build Windows /Control Pan:\

Output Windows  Subscript Control

2.2.3 The Build Window

Build window is used to create model in Vensim. By default, the window opens with the sketch tools for
sketching the structure of the model and for writing equations. The status bar provides buttons for
modifying the sketch. Each sketch view shows a part of the model, much like each page in a book tells
part of a story. In Vensim Professional and DSS, the build window can be switched to a text editor for

building and editing text-based models.

2.2.4 Sketch Tools

Sketch tools are grouped into a sketch toolset. Customized toolsets can be saved to files and reopened
for later use. The built in sketch toolset (default.sts) contains most of the sketch tools needed for

building models.
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Lock Variable Arrow Model Merge Comment Hide Equations
Variable \ Wand

[Em B ERN S RXE w

ooV N b Ay

Move/Size  Box Rate Shadow Input Unhide Delete Reference
Variable Variable Output Wand Modes
Object

Vensim PLE and PLE Plus do not contain the Model Variable, Merge, Unhide Wand or Hide Wand tools.

The sketch tools in the built in sketch toolset are:

Lock — sketch is locked. Pointer can select sketch objects and the Workbench Variable but
cannot move sketch objects.

Move/Size — move, sizes and selects sketch objects: variables, arrows, etc.

Variable — creates variables (Constants, Auxiliaries and Data).

Box Variable — create variables with a box shape (used for Levels or Stocks).

Arrow — creates straight or curved arrows.

Rate — creates Rate (or flow) construct, consisting of perpendicular arrows, a valve and, if

necessary, sources and sinks (clouds).

Model Variable — adds an existing model variable and the causes of that variable to the sketch

view.

Shadow Variable — adds an existing model variable to the sketch view as a shadow variable
(without adding its causes).

Merge — merges two variables into a single variable, merges Levels onto existing clouds,
merges Arrows onto a variable to split an Arrow, and performs other operations.

Input Output Object — adds input sliders and output graphs and tables to the sketch.
Sketch Comment — adds comments and pictures to the sketch.

Unhide Wand — unhide (makes visible) variables in a sketch view.

Hide Wand — hides variables in a sketch view.

Delete — deletes structure, variables in the model, and comments in a sketch.

Equations — create and edit model equations using the Equation Editor.

11



2.2.5 Status Bar

The status bar shows the state of the sketch and objects in the sketch. The status bar contains buttons

for changing the state of selected objects, and moving to another view.

G Yiew 1 |[#| Hide | Times NewRoman |12|b]i|uls| NS¢ I=] 2] %

A number of sketch attributes can be controlled from the status bar, including:
e Change characteristics on selected variables; font type, size, bold, italic, underline,
strikethrough.
e Set the hide level.
e Variable colors, box color, surround shape, text position, arrow color, arrow width, arrow
polarity, and etc.
e When using the ‘Text Editor’ (Vensim Professional and DSS), the Status Bar changes to reflect

text editing operations.

2.2.6 Output Windows

‘Output Windows, are generated by clicking on the ‘Analysis Tool’. The analysis tool gathers information
from the model and displays the information in a window as a diagram, graph, or text, depending on the
particular tool. Dozens of these windows can be open simultaneously, and a particular window can be
closed individually by clicking the Close button in the top left or top right corner, or all windows can be

closed at once using the menu item Windows>Close All Output.

2.2.7 Analysis Tool

The analysis tool is used to show information about the ‘Workbench’ variable, either its place or value in
the model, or its behaviour from the simulation datasets. Analysis tools are grouped into toolsets. To
configure a tool, user needs to click on the tool with the right mouse button and change its options.

Tools can also be added to a toolset. As with ‘Sketch’ toolsets, if the user makes changes he/she will be

12



prompted to save the toolset when exiting Vensim. Several different analysis toolsets are supplied with

Vensim, and can be opened from the menu Tools>Analysis Toolset>Open.

The following toolsets (Figure 2.4) are built-in.

PLE/Reader Plus DSS/Pro/Std
e e e
ocf o =]
@ @ @
Doc Doc Doc
= =4 =g
o A
=
2

Figure 2.4: Vensim built-in toolsets

A description of the functions of toolsets follows below.

2.2.8 Structural Analysis Tools

i

Causes Tree — creates a tree-type graphical representation showing the causes of the

Workbench Variable.

o<

Uses Tree — creates a tree-type graphical representation showing the uses of the Workbench

Variable.

&

Dac

Loops — displays a list of all feedback loops passing through the Workbench Variable.

Document — reviews equations, definitions, units of measure, and selected values for the

Workbench Variable.
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2.2.9 Dataset Analysis Tools

Causes Strip Graph — displays simple graphs in a strip, allowing the user to trace causality by

showing the direct causes (as shown) of the Workbench Variable.

Graph — displays behaviour in a larger graph than the Strip Graph, and contains different options

for output than the Strip Graph.

E Sensitivity Graph — creates a sensitivity graph of one variable and its range of uncertainty

generated from sensitivity testing.

|E| Bar Graph — creates a bar graph of a variable at a specific time, or displays a histogram of

variables over all times or across sensitivity simulations at a time.

—==ITable — generates a table of values for the Workbench Variable.

211 Table Running Down — table with time running down.

Funs

? . i .
<7 Runs Compare — compares all Lookups and Constants in the first loaded dataset to those in the

second loaded dataset.

*7 Statistics — provides summary statistics on the Workbench Variable and its causes or uses.

2.2.10 Other Tools

§2¢

Units Check — provides an alternative way to access the units check feature.
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Equation Editor — provides an alternative way to access the equation for the Workbench
Variable.

VEN
AFF Venapp Editor — supports the visual editing of Venapps.

ﬁu Text Editor — a general purpose text editor.

Further details about model ‘views’ are available in the Vensim User’s Guide, version10 (Ventana

Systems, 2010), which is distributed with the software.

2.3 Numerical Integration Technique

The integration technique is the method that Vensim uses to advance a model in time. In software
package like Vensim DSS, actual computation of simulation requires numerical integration. Several
different types of numerical integration are available: Euler, Diff, Runge-Kutta4 auto, Runge-Kutta4
fixed, Runge-Kutta2 auto, and Runge-Kutta2 fixed techniques (Ventana Systems, 2010). Euler integration is
the simplest and fastest numerical method, but is less accurate than the Runge-Kutta method. Diff
performs Euler integration but stores the values for Auxiliaries computed at the previous save time.
Regular Euler integration stores the values of Auxiliaries computed at the current save time. Diff, as its
name suggests, is intended primarily for difference equations where this reporting convention is often
used. Runge-Kutta is modification of Euler integration that improves accuracy substantially by checking
derivatives between the set time-intervals, without imposing a heavy computational burden. Several
different Runge-Kutta intervals can be chosen in Vensim: fixed step size of one-half (fixed RK2) and one-
quarter (fixed RK4), as well as automatic adjustments of step size, (RK2 auto and RK4 auto). RK4 Auto
performs fourth order Runge-Kutta integration with automatic adjustment of the step size to ensure
accuracy. This is the best choice, if the user wants an accurate answer quickly, but requires significantly
more computational effort than the other forms. Therefore, RK4 auto is the slowest of the numerical
integration techniques. RK4 Fixed performs fourth order Runge-Kutta integration with a fixed step size
specified by TIME_STEP. This is usually very accurate, but does not detect own inaccuracies. RK2 Auto

which performs second order Runge-Kutta integration with automatic adjustment of the step size. This
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is less accurate, but sometimes faster than RK4 auto. It is not recommended unless user feels there is a
special reason to use it. RK2 Fixed performs second order Runge-Kutta integration with a fixed step size.
This is faster than RK4 but more accurate than Euler. It is useful when both speed and accuracy are

important and difficult to achieve.

In the use of ANEMI model, user should avoid Runge-Kutta2 auto or Runge-Kutta4 auto, as the model
setup requires predefined time-step. Even though, ANEMI model is mostly build using system dynamic
based Vensim platform, still it has a dynamic link with outside computational environment (MATLAB). In
each time-step Vensim sends some information to MATLAB, to get a new set of parameters for the next
time step. Therefore it is essential to maintain same calculation time step for both programs. However,
if it seems time consuming to use the same time step then a predefined computational time step (in
such a case, the maximum computational time step between Vensim and MATLAB will work) should be

selected.

All numerical integration techniques require the selection of a discrete, finite ‘time-step’, at which
solutions are calculated for each simulated variable. This time step has a significant effect on model
behaviour, so its value must be chosen carefully to avoid the introduction of integration error into the
simulated values. Since integration error depends on the rate at which flows change relative to the
selected time step, faster rates of change in flows demand shorter time steps. The practical advice for

selection of an appropriate time step for system dynamics model is:

¢ Time steps should be divisible by 2, so that possible time step values are 1, 0.5, 0.25, 0.125, and so on;
¢ Time steps should be roughly one-quarter to one-tenth the size of the smallest time constant in the

model.

To test the suitability of the chosen time step, user needs to run a model simulation and check its
behaviour. When using Euler integration the improvement in the results is obtained by cutting the
integration period in half, and evaluationg if the result changes (Ventana Systems, 2010) — for example,
change the time step from 0.03125 to 0.015625. If the model behaviour matches between the two
simulations, the original time step is acceptable; however, if there is any change in behaviour then the
integration step should be cut further in half (0.0078128) and so on. If after using a small time step

simulation results mismatch then the user is advised to switch to RK4.
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2.4 An Example

This section will illustrate how a system dynamics based simulation model can be developed with

Vensim software.

2.4.1 Problem Description and Solution

Problem:
Consider a small subdivision of London that is growing in population. Land available for housing

development is obtained by converting the agricultural land into urban. The total available agricultural
land is limited and can support the growth up to a certain level. With more potential home customers in
the subdivision, land conversion from the available agricultural land will increase. With more land
converted, the more actual home customers there will be. However, the higher land conversion brings
awareness that the available agricultural land is limited, and that inversely affects potential home
customers. The more land converted reduces the available agricultural land and makes less urban land

available for new homes.

Subdivision has 100 potential home customers; if the land for development is available 2.5% of potential
customers each month may decide to move to the subdivision and become actual customers (assume
that units for land conversion are expressed using number of customers — one customer is equal to one

home plot of land); total agricultural land available is sufficient for 85 customers.

The solution of the problem follows the procedure as outlined:
(a) Development of a causal diagram for the problem;

(b) Development of the corresponding stock and flow diagram;
(c) Development of the Vensim model for the problem;

(d) Simulation of the Vensim model.
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Solution:

(a)

1. Startthe Vensim program from the Start Menu, and draw the causal loop diagram;

2. After opening the program, select ‘variable’ button (Auxiliary/Constant) and then click on the

workspace area to identify all the variables;

E] Vensim:Unnamed Var:FINAL TIME ‘

File Edit View Layout Model Tools
BEE | S|4 2@ EFECun
b @M [ B WP

<f
e

[ariakle - Auxiliary/Constant]

3. Select the arrow button to connect the appropriate variables in such a way that the arrow starts

from a cause and ends with a result, like; if number of ‘potential customers’ increases then the
land conversion rate should follow. In such a case user should start from the ‘Potential
customer’ and connect towards ‘Land conversion’ to keep arrow head towards in the right

direction. In the case of positive causality, the arrow head should be marked with ‘+ sign;

ﬂ] Vensim:Unnamed Var:FINAL TI

File Edit View Layout Mode
BEE & b’
br &M | B | W

o<p

®

After successfully connecting all the variables, the causal-loop diagram as in Figure 2.5 should be

obtained. Polarity of causal relationships determines the sign of the feedback loop (Sterman, 2000).

+

T otential - Land conversion

coustomer +

Actual customers

Figure 2.5: Causal-loop diagram (the negative feedback loop)
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1. Model development in Vensim. Before going further, the user should be able to distinguish

between ‘stock’ and “flow’ variables (detailed description is available in Ventana Systems, 2010;

and Sterman, 2000);

2. Forthe development of simulation model (stock and flow diagram), it’s better to start with a

new model, as casual loop diagram is not a simulation model. It only helps to formulate the

model structure. If the casual loop diagram is mixed with the model simulation file, the error

message could appear;

3. Select the model setting window to define the computational time step and simulation time

horizon (Figure 2.6)

Maodel Settings - use Sketch to set initial causes -e

Time Bounds | Info/Pswd | Sketeh | Units Equiv| LS Files | RefModes |

Time Bounds for Model Date Display

INITIAL TIME = [0 Label |Date
FINAL TIME = (100 Farmat  [v"-kkd-00

TIME STEF = |1 - Base date (at Time=0)
[v' Save results every TIME STEP ‘ear |2000

oruse SAVEPER = Maonth |1 hd
Units for Time  Month - Day
Integration Type m Units |Month =

MNOTE: To change later use Model>Settings or editthe equations for the I
above parameters.

QK | Cancel

]

Figure 2.6: Vensim model setting window

4. Select the ‘Box Variable’ button before drawing the variables in the workspace. User also needs
to select the ‘Rate’ button to make connection with the ‘stock’ variable through ‘flow rate’.

ﬂ] Vensim:Unnamed Er:FINI‘I’IME

File Edit View Layout Model Tools
BEE & 2B EFCure
e @ M | o[l B W WG

o

@

Box Wariable - Level
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File Edit View Layout Model
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After the completion of all the required connections the stock and flow diagram of the model
should be like the diagram in Figure 2.7, where ‘Potential Customer’ and ‘Actual Customer’ are

stocks representing number of customers. ‘Land conversion’ is working as a flow by

transforming ‘Potential Customer’ to ‘Actual Customer’.

Potential - Artual

Tz
Falkin
customer custoimer
Land
CONVErsion

Figure 2.7: Stock and flow diagram

(c)
1. Toincorporate the mathematical equations, the user needs to select the equation button before

clicking on any variable. After that, user will be able to edit the equation or incorporate equation

in the designated area (Figure 2.8).
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Editing equation for - Potential Customer e TIPS AN
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Initiz
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Type Undo | 7| 8| 9| + | Veriables|Functions|More |

e =

JLevel 01 4]s]s]- Choose Variable... | [Inmputs -]

Normal =l 1/2]| 3] = Potential Customer
[~ Supplementary ol & 7 Land Conversion
Help o [l =3 [

Units: | LJ

Com- >
ment: =
Group: | L’ Range: | | ] Go To: Prev| Next | ~h11t4 Sel.. I New
Errors:[Equation Modified -

OX Check Syntax I Check Model ] Delete Variable | Cancel [

Figure 2.8: Equation editor window

2. Define the initial conditions for the model two stocks. Insert ‘100’ and ‘0’ value for ‘Potential
Customer’ and ‘Actual Customer’ respectively. In this case at the beginning of the simulation
period, all of the customers (100) were potential customer as there was no home to handover,

which leads to zero number of actual customer.

3. In the problem description, it is mentioned that the project progress rate is aimed to transform
2.5% of potential customers to actual customer in each month. So the land conversion rate can
be defined as:

Land conversion = Potential customer*0.025

4. Vensim also allows user to visualize all the embedded equations under the diagram in the text

format, which looks as:

Actual customer= INTEG (
Land conversion,
0)

number of customer

Land conversion=

Potential customer*0.025
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~ number of customer

Potential customer= INTEG (
-Land conversion,
100)

~ number of customer

EE R E R R EE RS RIS SRS E RS RS E RS

.Control

KKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKKK KKK KKKk

Simulation Control Parameters

FINAL TIME =100

~ Month
~ The final time for the simulation.
/

INITIAL TIME =0

~ Month
~ The initial time for the simulation.
/

SAVEPER =

TIME STEP

~ Month [0,?]
~ The frequency with which output is stored.
/

TIME STEP =1
~ Month [0,?]

~ The time step for the simulation.



(d)

As the last step, model simulation is initiated by pressing ‘Run’ button from the Tool Bar. After
completion of the simulation, the user can visualize or extract the results file, both in graphical and

numerical format.

In the problem description, it is mentioned that the total land available is sufficient for 85 customers. So,
from the graph of actual customers (Figure 2.9), it can be seen that 75 months would be sufficient to sell

all the properties within the subdivision.

Actual customer

100

75

50

25

ol 10 20 30 40 50 &0 70 30 a0 100
Time (Month)

Figure 2.9: Time series plot of the number of actual customers
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3 ANEMI MODEL

3.1 Model Organization and Mathematical Basis

The ANEMI version 2 model captures interconnections between main elements of the complex society-
biosphere-climate-economy-energy system like global surface temperature, global CO, concentration,
average annual surface flow, population growth, economic output, energy consumption, wastewater

volume, and others (Akhtar et al, 2011).

The system dynamics models include two levels of model representation: (i) a diagrammatic
representation of the causal connections that constitute the system under study, and (ii) the

mathematical basis of those connections in the form of equations.

Vensim allows the user to separate the model in many ways at the diagrammatic level. This unique
facility supports the ANEMI model structure — nine model sectors are developed using multiple system
dynamics diagrams. Conceptually, the sectoral view helps the user to focus on any specific sector by
drawing boundaries around the processes of importance in that part of the model. While looking at the
integrated modelling structure it is not uncommon that the majority of variables in one sector are not
relevant to the rest of the model, and their number within an individual sector is generally significantly
higher than the number of equations that connect different sectors. Finally, model division into
subsystems separates the relevant from the irrelevant variables, so that only key variables — those

involved in intersectoral feedbacks — are visible to the rest of the model.

The global version of ANEMI model is divided into fourteen subsystem views, which in most cases
correspond to model sectors. Those subsystems, which are not treated as sectors, are mainly introduced
to make the visual representation more tidy and convenient for the model user. These fourteen views of
nine ANEMI sectors are introduced in the Vensim DSS model version through the ‘view selector’ located

at the bottom of the main screen or by pressing the ‘page up’ and ‘page down’ key.

T
Climate D  |@| Hide |Times New Roman [12]b]i|uls|IIMS]:
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The model views are presented below in the following order (from Figure 3.1 through Figure 3.14):

carbon, other gasses, climate, climate_Nordhaus, land-use, food production, hydrologic cycle (water

guantity), water demand, water quality, water stress, population, emission, energy-economy, and sea-

level rise.
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Figure 3.1: View of the ‘carbon’ sector
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Figure 3.2: View of the ‘other gasses’ subsystem

25



Edt View

start1980_newd mdl Var:Atmospheric CO2 Concentration
Model Tedls Windaes Help

g & i:@

A% [s1art1980_newa_base_tax A F YRR SR Db

polE@M i B RN EH HXG w D
@ 7 e

EHOOUR® 7 e

g
<Total Rudiathe frcing emgerature
Use a Comtast 057 " tromvarious pasres
i e
ey o P g
IS, | "
Atmorghere Concustiatio, / Climata Sassitivity h
it T » —

Atmospheric Sector Constants

Sips R Eumk Sacends per Tass

EL g

&

Model Tools Windows Help

m 7 iy
ot
Y el gt
— v e
e - |
— ! huetrcam
Fal Eusstity Bracint e
Y /

4 e bltipher
s Lociey
e \\___/

B Fl  DeltaToel

BEH| & & @ ¥ [start1980_new4_base_tax

[ #Fhe Y BE | &2 D6

= 3 '
EA Y P AN A AN X IS 4
@ ]
@
Poc Peindustral CO2 <Cin
CO2 Rad Force Cosfl Atmosphere=
B €02 in Atm
/
g €02 Rad Force
T Tum On =Total Radistive foreing fi
Climats Feodback Pasam Endogenons foreing sions gasses sxcapt C>
=]
a7 Radiative Foreing ‘\\Gafp
1o 13 oxci
: Faference Temperature Feedback Cooling Other GHG Rad Fozcing
¥ Climste Damags Sl
Turn On Nordhaus 3 2 A UO Heat Cap
e Climate Sector /
Ve Atmos
- Climate Damage Frac UOcean
fa Temp Chg & 10 Taary,
\ Heat Trans Coofl
cument Atims
. S 0zsan Temp
Clmate D Honlisanty Temp DH\»H!A‘ Transfer
temperatue change from <Initial Atm
: -~ eat Cay
ordhas climate secter Temperaturer DO Heat Cap
CheDO Tartp
Heat Capasity Ratio

< I3 |

|7 Climate_new [¥[ Hide [ Times NewFoman [12]b] i [ul s (ST ST 20T

Figure 3.4: View of the ‘climate_Nordhause’ subsystem

26



File

AFE & ¥ EB@ EF|stean]980_newd base tax

€02 Concentration
Edic view Model Tools Windows Help

ABRY EE S 2O

3 -
[Em ksh d WA 0 X w 3
TIME STEP a
N . FAO Cultivable Land
Tum On Altersd
= Lard Uss Patterm FAQ Aginitural Lad
Doc FAO Arable Land
” Init Transfer Matrix
population ST/ Tynsfi Maltiplier - Initial Values Transfer M
) e Tttt o ) et P
Popdation Transfor Bates Cueducacic
= Gmw\h zater / M %
Initial transfor atzix
Transfer
[ A For Base case(ail)
atny (ai) Init Trarsfer g
<Population (1= opintion ineresse. <ffective poyulation estaons Ll Tric Drain T Matie () ¥
= ot gy r\f\:h Fate Tabss B Inital Transfr Matrix
P v o2 10% incpease( i)
z it Biosus Avea
X0 et o Titial Traster Mateix
Transtes A NewTamtr atrix Multplier fox for 20% increase(aii)
¥ Matrix(a) atrix(a) Decrease of an 2
i Final Transfer Haan Fozestuea Mateix o
e xmm of n,,.,, M)
e e Transformation
A [Rest e Decroted et
% ¥ e
Taontn | e
e intamadiste Land Use e
Nondizg Trarsf -y aupporting
Matrix Entriss ~-grimitural Are cal Matrix
Intemdiste Stap
Change from Each
Chiasgs to Each Biome Azea
Bioms Area
L for Biess
any
.
TIMESTEP- e i Pastare
arsbls Jand
h . Rl Lend- el v
< >
3] LandUse [@] Hide | TimesNewRoman [12[b[i [uls MMM 0%

Figure 3.5: View of the ‘land-use’ sector
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Figure 3.7: View of the ‘hydrologic cycle’ sector
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Figure 3.8: View of the ‘water demand’ sector
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